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Release Notes
Release 1.0.1475
This is the first preliminary release of the CORIOLIS 2 framework.
This release mainly ships the global router KNIK and the detailed router KITE. Together they

aim to replace the ALLIANCE NERO router. Unlike NERO, KITE is based on an innovating routing
modeling and ad-hoc algorithm. Although it is released under GPL license, the source code will
be avalaible later.
Contents of this release:

1. A graphical user interface (viewer only).
2. The KNIK global router.
3. The KITE detailed router.

Supported input/output formats:
• ALLIANCE vst (netlist) & ap (physical) formats.
• Even if there are some references to the CADENCE LEFDEF format, its support is not included
because it depends on a library only available to SI2 affiliated members.

Release 1.0.1963
Release 1963 is alpha. All the tools from CORIOLIS 1 have been ported into this release.
Contents of this release:

1. The STRATUS netlist capture language (GENLIB replacement).
2. The MAUKA placer (still contains bugs).
3. A graphical user interface (viewer only).
4. The KNIK global router.
5. The KITE detailed router.
6. Partially implemented python support for configuration files (alternative to XML).
7. A documentation (imcomplete/obsoleted in HURRICANE’s case).

Release 1.0.xxxx
Release xxxx is RC1.
Changes of this release:

1. The HURRICANE documentation is now accurate. Documentation for the Cell viewer
and CRLCORE has been added.

2. More extensive Python support for all the components of CORIOLIS.
3. Configuration is now completly migrated under Python. XML loaders can still be
useds for compatibilty.

4. The cgtmain has been rewritten in Python.
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Installation
Binary packages avalaible:

Distribution Package
SCIENTIFIC LINUX 6

coriolis2-1.0.xxxx-1.slsoc6.i686.rpm
coriolis2-1.0.xxxx-1.slsoc6.x86_64.rpm

FEDORA 16
coriolis2-1.0.xxxx-1.fc16.i686.rpm
coriolis2-1.0.xxxx-1.fc16.x86_64.rpm

UBUNTU 10.04 LTS
coriolis2_1.0-xxxx-1_.i386.rpm (10.04)
coriolis2_1.0-xxxx-1_.amd64.rpm (10.04)

UBUNTU 12.04 LTS
coriolis2_1.0-xxxx-1_.i386.rpm (12.04)
coriolis2_1.0-xxxx-1_.amd64.rpm (12.04)
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Coriolis Configuration & Initialisation
All configuration & initialization files are Python scripts, despite their .conf extention. From a
syntactic point of view, there is no difference between the system-wide configuration files and
the user’s configuration, they may use the same Python helpers.
The initialization process is done by executing, in order, the following file(s):

Order Meaning File
1 The system initialization /etc/coriolis2/coriolisInit.py
2 The user’s global initialization ${HOME}/.coriolis2.conf
3 The user’s local initialization <CWD>/.coriolis2.conf

Note
The loading policy is not hard-coded. It is implemented at Python level in
coriolisInit.py, and thus may be easyly be amended to whatever site policy.
The truly mandatory requirement is the existence of coriolisInit.py which
must contain a coriolisConfigure() function with no argument.

Configuration Helpers
To ease the writing of configuration files, a set of small helpers is available. They allow to setup
the configuration parameters through simple assembly of tuples.

ALLIANCE Helper
The configuration file must provide a allianceConfig tuple of the form:

cellsTop = ’/soc/alliance/cells/’

allianceConfig = \
( ( ’SYMBOLIC_TECHNOLOGY’, helpers.sysConfDir+’/technology.symbolic.xml’ )
, ( ’REAL_TECHNOLOGY’ , helpers.sysConfDir+’/technology.cmos130.s2r.xml’)
, ( ’DISPLAY’ , helpers.sysConfDir+’/display.xml’ )
, ( ’CATALOG’ , ’CATAL’)
, ( ’WORKING_LIBRARY’ , ’.’)
, ( ’SYSTEM_LIBRARY’ , ( (cellsTop+’sxlib’ , Environment.Append)

, (cellsTop+’dp_sxlib’, Environment.Append)
, (cellsTop+’ramlib’ , Environment.Append)
, (cellsTop+’romlib’ , Environment.Append)
, (cellsTop+’rflib’ , Environment.Append)
, (cellsTop+’rf2lib’ , Environment.Append)
, (cellsTop+’pxlib’ , Environment.Append) ) )

, ( ’SCALE_X’ , 100)
, ( ’IN_LO’ , ’vst’)
, ( ’IN_PH’ , ’ap’)
, ( ’OUT_LO’ , ’vst’)
, ( ’OUT_PH’ , ’ap’)
, ( ’POWER’ , ’vdd’)
, ( ’GROUND’ , ’vss’)
, ( ’CLOCK’ , ’^ck.*’)
, ( ’BLOCKAGE’ , ’^blockageNet*’)
)
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The example above shows the system configuration file, with all the available settings. Some
important remarks about thoses settings:
• In it’s configuration file, the user do not need to redefine all the settings, just the one he
wants to change. In most of the cases, the SYSTEM_LIBRARY, the WORKING_LIBRARY and
the special net names (at this point there is not much alternatives for the others settings).

• SYSTEM_LIBRARY setting: Setting up the library search path. Each library entry in the tuple
will be added to the search path according to the second parameter:
• Environment::Append: append to the search path.
• Environment::Prepend: insert in head of the search path.
• Environment::Replace: look for a library of the same name and replace it, whithout
changing the search path order. If no library of that name already exists, it is ap-
pended.

A library is identified by it’s name, this name is the last component of the path name.
For instance: /soc/alliance/sxlib will be named sxlib. Implementing the ALLIANCE
specification, when looking for a Cell name, the system will browse sequentially trought the
library list and returns the first Cell whose name match.

• For POWER, GROUND, CLOCK and BLOCKAGE net names, a regular expression (GNU regexp) is
expected.

• The helpers.sysConfDir variable is supplied by the helpers, it is the directory in which
the system-wide configuration files are locateds. For a standard installation it would be:
/soc/coriolis2.

• Trick and naming convention about SYMBOLIC_TECHNOLOGY, REAL_TECHNOLOGY and DISPLAY.
In the previous releases, thoses files where to read by XML parsers, and still do if you trig-
gers the XML compatibility mode. But now, they have Python conterparts. In the configu-
ration files, you still have to name them as XML files, the Python file name will be deduced
from this one with thoses two translation rules:
1. In the filename, all dots, except for the last (the file extention), are replaced by
underscores.

2. The .xml extention is substituted by a .conf.
For the symbolic technology, it would give:

/soc/coriolis2/technology.symbolic.xml
--> /soc/coriolis2/technology_symbolic.conf

A typical user’s configuration file would be:
import os

homeDir = os.getenv(’HOME’)

allianceConfig = \
( (’WORKING_LIBRARY’ , homeDir+’/worklib’)
, (’SYSTEM_LIBRARY’ , ( (homeDir+’/mylib’, Environment.Append) ) )
, (’POWER’ , ’vdd.*’)
, (’GROUND’ , ’vss.*’)
)
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Tools Configuration Helpers
All the tools uses the same helper to load their configuration (a.k.a. Configuration Helper). Cur-
rently the following configuration system-wide configuration files are defined:
• misc.conf: commons settings or not belonging specifically to a tool.
• nimbus.conf: for the NIMBUS tool.
• hMetis.conf: for the HMETIS wrapper.
• mauka.conf: for the MAUKA tool.
• kite.conf: for the KITE tool.
• stratus1.conf: for the STRATUS1 tool.
Here is the contents of mauka.conf:
# Mauka parameters.
parametersTable = \

( (’mauka.annealingBinMult’ , TypePercentage, 5 )
, (’mauka.annealingNetMult’ , TypePercentage, 90 )
, (’mauka.annealingRowMult’ , TypePercentage, 5 )
, (’mauka.ignorePins’ , TypeBool , False )
, (’mauka.insertFeeds’ , TypeBool , True )
, (’mauka.plotBins’ , TypeBool , True )
, (’mauka.searchRatio’ , TypePercentage, 50 )
, (’mauka.standardAnnealing’, TypeBool , False )
)

layoutTable = \
( (TypeTab , ’Mauka’, ’mauka’)
# Mauka part.
, (TypeOption, "mauka.standardAnnealing", "Standart Annealing" , 0 )
, (TypeOption, "mauka.ignorePins" , "Ignore Pins" , 0 )
, (TypeOption, "mauka.plotBins" , "Plot Bins" , 0 )
, (TypeOption, "mauka.insertFeeds" , "Insert Feeds" , 0 )
, (TypeOption, "mauka.searchRatio" , "Search Ratio (%)" , 1 )
, (TypeOption, "mauka.annealingNetMult" , "Annealing Net Mult (%)", 1 )
, (TypeOption, "mauka.annealingBinMult" , "Annealing Bin Mult (%)", 1 )
, (TypeOption, "mauka.annealingRowMult" , "Annealing Row Mult (%)", 1 )
, (TypeRule ,)
)

Taxonomy of the file:
• It must contains, at least, the two tables:

• parametersTable, defines & initialise the configuration variables.
• layoutTables, defines how the various parameters will be displayed in the configu-
ration window

• The parametersTable, is a tuple (list) of tuples. Each entry in the list describe a con-
figuration parameter. In it’s simplest form, it’s a quadruplet (TypeOption, ’paramId’,
ParameterType, DefaultValue) with:
1. TypeOption, tells that this tuple describe a parameter.
2. paramId, the identifier of the parameter. Identifiers are defined by the tools.
The list of parameters is detailed in each tool section.
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3. ParameterType, the kind of parameter. Could be:
• TypeBool, boolean.
• TypeInt, signed integer.
• TypeEnumerate, enumerated type, needs extra entry.
• TypePercentage, percentage, expressed between 0 and 100.
• TypeDouble, float.
• TypeString, character string.

4. DefaultValue, the default value for that parameter.

CGT - The Graphical Interface
The CORIOLIS graphical interface is split up into two windows.
• The Viewer, with the following features:

• Basic load/save capabilities.
• Display the current working cell. Could be empty if the design is not yet placed.
• Execute Stratus Scripts.
• Menu to run the tools (placement, routage).

Features are detailed in Viewer & Tools.

• The Controller, which allows:

LIP6/SoC 8
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• Tweak what is displayer by the Viewer. Through the Look, Filter and Layers&Gos tabs.
• Browse the netlist with eponym tab.
• Show the list of selected objects (if any) with selection
• Walk through the Database, the Cell or the Selection with Inspector. This is an ad-
vanced feature, reserved for experimented users.

• The tab Settings which give access to all the settings. They are closely related to Con-
figuration & Initialisation.

Viewer & Tools
The HURRICANE Data-Base
The ALLIANCE flow is based on the MBK data-base, which has one data-structure for each view.
That is, Lofig for the logical view and Phfig for the physical view. The place and route tools were
responsible for maintaining (or not) the coherency between views. Reflecting this weak coupling
between views, each one was stored in a separate file with a specific format. The logical view is
stored in a vst file in VHDL format and the physical in an ap file in an ad-hoc format.
The CORIOLIS flow is based on the HURRICANE data-base, which has a unified structure for log-

ical and physical view. That data structure is the Cell object. The Cell can have any state between
pure netlist and completly placed and routed design. Although the memory representation of
the views has deeply changed we still use the ALLIANCE files format, but they now really repre-
sent views of the same object. The point is that one must be very careful about view coherency
when going to and from CORIOLIS.
As for the first release, CORIOLIS can be used only for two purposes :
• Routing a design, in that case the netlist view and the layout view must be present and
layout view must contain a placement. Both views must have the same name. When
saving the routed design, it is advised to change the design name otherwise the original
unrouted placement in the layout view will be overwritten.

LIP6/SoC 9
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• Viewing a design, the netlist view must be present, if a layout view is present it still must
have the same name but it can be in any state.

Mauka -- Placer
Mauka makes uses of hMetis.
To be completed...

Note
Instance Duplication Problem: a same logical instance cannot have two different
placements. So, either youmanually make a clone of it or you supply a placement
for it. This is currently a drawback of our folded hierarchy approach.

Knik -- Global Router
The global router is (not yet) deterministic. To circumvent this limitation, a global routing (also
called a solution) can be saved to disk and reloaded for later uses.
A global routing is saved into a file with the same name as the design and a kgr extention. It

is in Box Router output format.
For an in-depth description of KNIK algorithms, you may download the thesis of D. DUPUIS

avalaible from here~: Knik Thesis.
Menus:
• P&R → Step by Step → Save Global Routing .
• P&R → Step by Step → Load Global Routing .

Kite -- Detailed Router
KITE no longer suffers from the limitations of NERO. It can route big designs as its runtime and
memory footprint is almost linear (with respect to the number of gates). It has successfully
routed design of more than 150K gates.
However, this first release has the following restrictions:
• Works only with SXLIB standard cell gauge.
• Works always with 4 routing metal layers (M2 through M5).
• Do not allow (take into account) pre-routed wires on signals other than POWER or GROUND.
After each run, KITE displays a set of completion ratios which must all be equal to 100% if

the detailed routing has been successfull. In the event of a failure, on saturated design, you
may decrease the edge saturation ration (argument --edge) to balance more evenly the design
saturation. That is, the maximum saturation decrease at the price of a wider saturated area and
increased wirelength.
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Routing a design is done in three ordered steps:
1. Global routing P&R → Step by Step → Global Route .
2. Detailed routing P&R → Step by Step → Detailed Route .
3. Finalize routing P&R → Step by Step → Finalize Route .
After the detailed routing step the KITE data-structure is still active. The wiring is thus repre-

sented in a way that allows KITE to manage it but which is not completly finished. The finalize
step performs the removal of the KITE data-structure and finish/cleanup the wiring so that its
connex in the sense of HURRICANE. Do not try to save your design before that step, you would
get gaps in it.
The complete description of KITE parameters are described in Detailed Routing Configura-

tion Parameters.

Executing Python Scripts in Cgt
Python/Stratus scripts can be executed either in text or graphical mode.

Note
How Cgt Locates Python Scripts. cgt uses the Python import mechanism to load
Python scripts. So you must give the name of your script whitout .py extention
and it must be reachable through the PYTHONPATH. You may uses the dotted mod-
ule notation.

A Python/Stratus script must contains a function called StratusScript with one optional
argument, the graphical editor into which it may be running (will be set to None in text mode).
Any script given on the command line will be run immediatly after the initializations and

before any other argument is processed.
Small example of Python/Stratus script:
from status import *

def doSomething ():
# ...
return

def StratusScript ( editor=None ):
if globals().has_key ( "__editor" ): editor = __editor
if editor: setEditor ( editor )

doSomething()
return

if __name__ == "__main__" :
StratusScript ()

This script could be run directly with Python (thanks to the two last lines) or through cgt in
both text and graphical modes.

Printing & Snapshots
Printing or saving into a PDF is fairly simple, just uses the File -> Printmenu or the CTRL + p
shortcut to open the dialog box.
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The print functionality uses exactly the same rendering mechanism as for the screen, beeing
almost WYSIWYG. Thus, to obtain the best results it is advisable to select the Coriolis.Printer
look (in the Controller), which uses a white background and much suited for high resolutions
32x32 pixels patterns
There is also two mode of printing selectable through the Controller Settings -> Misc ->Printer/Snapshot Mode:

Mode DPI (approx.) Intended Usage
Cell Mode 150 For single Cell printing or very small designs. Patterns

will be bigger and more readable.
Design Mode 300 For designs (mostly commposed of wires and cells out-

lines).

Note
The pdf file size Be aware that the generated PDF files are indeed only pixmaps. So
they can grew very large if you select paper format above A2 or similar.

Saving into an image is subject to the same remarks as for PDF.

Memento of Shortcuts in Graphic Mode
The main application binary is cgt.

Category Keys Action
Moves

Up , Down
Left , Right

Shift the view in the according direction

Fit f Fit to the Cell abutment box
Refresh CTRL + l Triggers a complete display redraw
Goto G apperture is the minimum side of the area displayed

around the point to go to. It’s an alternative way of set-
ting the zoom level

Zoom z , m Respectively zoom by a 2 factor and unzoom by a 2 factor

Area Zoom

You can perform a zoom to an area. Define the zoom
area by holding down the left mouse button while moving
the mouse.

Selection

Area Selection

You can select displayed objects under an area. Define
the selection area by holding down the right mouse button
while moving the mouse.

... continued on next page

LIP6/SoC 12



Documentation SoC Avril 2012

Category Keys Action

Toggle Selection

You can toggle the selection of one object under the
mouse position by pressing CTRL and pressing down
the right mouse button. A popup list of what’s under the
position shows up into which you can toggle the selec-
tion state of one item.

S Toggle the selection visibility
Controller CTRL + i Show/hide the controller window.

It’s the Swiss Army Knife of the viewer. From it, you can
fine-control the display and inspect almost everything in
your design.

Rulers k , ESC One stroke on k enters the ruler mode, in which you
can draw one ruler. You can exit the ruler mode by
pressing ESC . Once in ruler mode, the first click on the
left mouse button sets the ruler’s starting point and the
second click the ruler’s end point. The second click exits
automatically the ruler mode.

K Clears all the drawn rulers
Print CTRL + p Currently rather crude. It’s a direct copy of what’s dis-

played in pixels. So the resulting picture will be a little
blurred due to anti-aliasing mechanism.

Open/Close CTRL + o Opens a new design. The design name must be given
without path or extention.

CTRL + w Close the current viewer window, but do not quit the
application.

CTRL + q CTRL+Q quit the application (closing all windows).

Hierarchy CTRL + Down Go one hierarchy level down. That is, if there is an in-
stance under the cursor position, load it’s model Cell in
place of the current one.

CTRL + Up Go one hierarchy level up. if we have entered the cur-
rent model through CTRL + Down , reload the previ-
ous model (the one in which this model is instanciated).

Cgt Command Line Options
Appart from the obvious --text options, all can be used for text and graphical mode.

Arguments Meaning
-t|--text Instruct cgt to run in text mode.
-L|--log-mode Disable the uses of ANSI escape sequence on the tty.

Useful when the output is redirected to a file.
-c <cell>|--cell=<cell> The name of the design to load, without leading path

or extention.
-g|--load-global Reload a global routing solution from disk. The file con-

taining the solution must be named <cell>.kgr.
... continued on next page
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Arguments Meaning
--save-global Save the global routing solution, into a file named <de-

sign>.kgr.
-e <ratio>|--edge=<ratio> Change the edge capacity for the global router, be-

tween 0 and 1 (KNIK).
-G|--global-route Run the global router (KNIK).
-R|--detailed-route Run the detailed router (KITE).
-s|--save-design=<routed> The design into which the routed layout will be saved.

It is strongly recommanded to choose a different name
from the source (unrouted) design.

--events-limit=<count> The maximal number of events after which the router
will stops. This is mainly a failsafe against looping. The
limit is sets to 4 millions of iteration which should suf-
fice to any design of 100K. gates. For bigger designs you
may wants to increase this limit.

--stratus-script=<module> Run the Python/Stratus script module. See Python
Scripts in Cgt.

Some Examples :
• Run both global and detailed router, then save the routed design :

> cgt -v -t -G -R --cell=design --save-design=design_kite

• Load a previous global solution, run the detailed router, then save the routed design :
> cgt -v -t --load-global -R --cell=design --save-design=design_kite

• Run the global router, then save the global routing solution :
> cgt -v -t -G --save-global --cell=design

The Controller
The Controller window is composed of seven tabs:

1. The Look Tab to select the display style.
2. The Filter Tab the hierarchical levels to be displayed, the look of rubbers and the
dimension units.

3. The Layers&Go Tab to selectively hide/display layers.
4. The Netlist Tab to browse through the netlist. Works in association with the Selection
tab.

5. The Selection Tab allow to view all the currently selected elements.
6. The Inspector Tab browse through either the DataBase, the Cell or the current selec-
tion.

7. The Settings Tab access all the tool’s configuration settings.
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The Look Tab
You can select how the layout will be displayed. There is a special one Printer.Coriolis specifi-
cally designed for Printing & Snapshots. You should select it prior to calling the print or snapshot
dialog boxes.

The Filter Tab
The filter tab let you select what hierarchical levels of your design will be displayed. Hierarchy
level are numbered top-down: the level 0 correspond to the top-level cell, the level one to the
instances of the top-level Cell and so on.
There are also check boxes to enable/disable the processing of Terminal Cell, Master Cells

and Compnents. The processing of Terminal Cell (hierarchy leaf cells) is disabled by default
when you load a hierarchical design and enabled when you load a single Cell.
You can choose what kind of form to give to the rubbers and the type of unit used to display

coordinates.
Note
What are Rubbers: HURRICANE uses Rubbers to materialize physical gaps in net
topology. That is, if some wires are missing to connect two or more parts of net,
a rubber will be drawn between them to signal the gap.
For example, after the detailed routing no rubbers should remains. They have
been made very visibles as big violet lines...
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The Layers&Go Tab
Control the individual display of all layers and Gos.
• Layers correspond to a true physical layer. From a HURRICANE point of view they are all the
BasicLayers (could be matched to GDSII).

• Gos stands from Graphical Objects, they are drawings that have no physical existence but
are added by the various tools to display extra information. One good exemple is the
density map of the detailed router, to easily locate congested areas.

For each layer/Go there are two check box:
• The normal one triggers the display.
• The red-outlined allows objects of that layer to be selectable or not.
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The Netlist Tab
The Netlist tab shows the list of nets... By default the tab is not synched with the displayed Cell.
To see the nets you must check the Sync Netlist checkbox. You can narrow the set of displayed
nets by using the filter pattern (supports regular expressions).
An very useful feature is to enable the Sync Selection, which will automatically select all the

components of the selected net(s). You can select multiple nets. In the figure the net auxsc35 is
selected and is highlited in the Viewer.
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The Selection Tab
The Selection tab list all the components currently selecteds. They can be filtered thanks to the
filter pattern.
Used in conjunction with the Netlist Sync Selection you will all see all the components part

of net.
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In this list, you can toggle individually the selection of component by pressing the t key.
When unselected in this way a component is not removed from the the selection list but instead
displayed in red italic. To see where a component is you may make it blink by repeatedly press
the t key...

The Inspector Tab
This tab is very useful, but mostly for CORIOLIS developpers. It allows to browse through the live
DataBase. The Inspector provide three entry points:
• DataBase: Starts from the whole HURRICANE DataBase.
• Cell: Inspect the currently loaded Cell.
• Selection: Inspect the object currently highlited in the Selection tab.
Once an entry point has been activated, you may recursively expore all it’s fields using the

right/left arrows.

Note
Do not put your fingers in the socket: when inspecting anything, do not modify
the DataBase. If the any object under inspection is deleted, you will crash the
application...

Note
Implementation Detail: the inspector support is done with Slot, Record and
getString().
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The Settings Tab
Here comes the description of the Settings tab.
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Tools Fine Tuning
Detailed Routing Configuration Parameters

Parameter Identifier Type Default
Katabatic Parameters
katabatic.globalLengthThreshold
katabatic.saturateRatio
katabatic.saturateRp
kite.borderRipupLimit

TypeInt
TypePercentage
TypeInt
TypeInt

1450
80
8
26

Kite Parameters
kite.edgeCapacity
kite.eventsLimit
kite.ripupCost
kite.globalRipupLimit
kite.localRipupLimit
kite.longGlobalRipupLimit
kite.strapRipupLimit
kite.metal1MinBreak
kite.metal2MinBreak
kite.metal3MinBreak
kite.metal4MinBreak
kite.metal5MinBreak
kite.metal6MinBreak
kite.metal7MinBreak

TypePercentage
TypeInt
TypeInt
TypeInt
TypeInt
TypeInt
TypeInt
TypeDouble
TypeDouble
TypeDouble
TypeDouble
TypeDouble
TypeDouble
TypeDouble

65
4000002
3
5
7
5
16
100
100
100
1450
1450
1450
1450
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